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 ‘CCC’ TEST PAPERS 
 
1 In which menu Spelling command appears  
(A)Tools (B)Windows (C)Edit (D)None of the above 
 
2 A right click on the Windows desktop itself will _____.  
(A)open the Display Properties dialog box  
(B)show a context-sensitive menu  
(C)open the Control Panel  
(D)minimize all open applications 
 
3 "When numbers are typed inside a cell, the default alignment is:"  
(A)Left-aligned (B)Center-aligned (C)Right-aligned (D)Justified 
 
4 Cell address A$4 in a formula means it is a  
(A)relative cell reference  
(B)absolute cell reference  
(C)mixed cell reference  
(D)All of the above 
 
5 When you create a chart on a separate sheet in the same workbook it is 
called a  
(A)chart sheet (B)embedded chart (C)view sheet (D)view chart 
 
6 Page break command of Excel on the Insert menu will result in insertion of 
page break  
(A)above the selected row  
(B)below the selected row  
(C)middle of the selected row  
(D)None of the above 
 
7 To print a specific area in Excel  
(A)set print area from File menu  
(B)set print area from Page Setup dialog box  
(C)both a and b above  
(D)None of the above 
 
8 Pressing _____ is a quick way to cycle between open program windows.
 (A)Alt+Tab (B)Ctrl+Tab (C)Shift+Tab (D)Shift+Alt 
 
9 The AutoContent Wizard creates _____.  
(A)a new blank presentation with an attractive background and  fonts  
(B)a new presentation with sample slides with suggestions for  what information 
should be included  
(C)a new look for an existing presentation  
(D)a new template for future use 
 
10 "In PowerPoint, slide sorter command is found under which menu?"  
(A)File (B)Tools (C)View (D)Edit 
 
11 The primary goal for your slide design should be _____.  
(A)to attract the eyes of your audience  



 

 

(B)to coordinate with your company logo and color scheme  
(C)to make the information easy to read  
(D)to make the slides interesting and even exciting 
 
12 "In Excel, shortcut fill menu contain"  
(A)Fill weekdays (B)Fill series (C) (a) and (b) (D)None of these 
 
13 Alignment buttons are available on the _____ toolbar.  
(A)Status bar  (B)Formatting toolbar  (C)Standard toolbar (D)None of these 
 
14 Paste Special dialog box of Excel contains _____ options for 
(A)characteristics (B)Formats Formulas (C)Values (D)All of the above 
 
15  "Actions buttons can be inserted in the slide, by Action Button command of" 
(A)View menu  (B)Insert menu (C)Slide show menu  (D)None of the above 
 
16 "If you import data and want to update the slide when the original data 
changes, you must _____."  
(A)embed the data  
(B)link the data  
(C)Insert the data as an object  
(D)break the link 
 
17 Following is a type of PowerPoint Slide Show option  
(A)Presented by the speaker  
(B)Browsed by an individual  
(C)Browsed at a kiosk  
(D)All of the above 
 
18 The first network that planted the seeds of Internet was:  
(A)ARPANET (B)NSFnet (C)Vnet (D)Inet 
 
19 "For a small Web site, one needs to buy space from the"  
(A)Network administrator (B)Telephone exchange (C)ISP (D)None of the above 
 
20 The first graphical browser for the WWW was named:  
(A)Netscape (B)Veronica (C)Mosaic (D)Lynx 
 
21 The Internet uses  
(A)Circuit switching  
(B)Packet switching  
(C)Hybrid switching  
(D)None of the above 
 
22 GIGO stands for _____.  
(A)"Garbage Input, Garbage Output"  
(B)"Gigabytes in, Gigabytes out"  
(C)"Garbage In, Garbage Out"  
(D)None of the above 
 
23 "When a computer prints a report, this output is called_____."  
(A)hard copy (B)soft copy (C)COM (D)None of the above 
 

24 CPU reads the information from secondary memory  
(A)Directly  
(B)"First, information is transferred to main memory and from   there, the CPU 
reads"  



 

 

(C)Through registers  
(D)None of these 
 
25 Which of the following in not an option of edit menu in PowerPoint?
 (A)Cut (B)Delete slide (C)Copy (D)Page setup 
 
 
26 You can create a template in Word  
(A)based on an existing document  
(B)based on an existing template  
(C)from scratch  
(D)All the above 
 
27 A Laser printer uses  
(A)Raster scan  
(B)Camera lens  
(C)Heat sensitive paper  
(D)None of these 
 
28 Tape storage is primarily used for _____.  
(A)backups  
(B)installing new programs  
(C)rarely used software  
(D)None of the above 
 
29 GUI is used as an interface between  
(A)hardware and software  
(B)man and machine  
(C)software and user  
(D)None of the above 
 
30 A Word processor is:  
(A)"A program which processes the word, e.g. giving frequency   of words, 
sorting of words etc"  
(B)"A program which provides the facility for creating, viewing   editing and 
manipulating text before printing"  
(C)CPU of microcomputer  
(D)None of these 
 
31 E-mail is  
(A)Mail concerning electronics devices  
(B)"Transaction of letters, messages and memos over a    communications network" 
(C)Transaction of messages within a computer  
(D)None of these 
 
32 Using Microsoft Word’s Find and Replace feature you can  
(A)replace both text and formatting  
(B)replace text of a document only  
(C)replace formatting only  
(D)replace document’s name with a new name 
 
33 "When you activate the Spelling and Grammar checker,"  
(A)it displays the misspelled words in a dialog box.  
(B)it highlights the misspelled words in the document.  
(C)it allows you to either correct the misspelled word  manually.  
(D)All of the above 
 



 

 

34 You will probably use Borders in Word where  
(A)you wish to add emphasis to particular paragraphs  
(B)you wish to draw lines above and below or to left and right  of paragraphsyou 
(C)wish to surround the paragraphs with different styles  of boxes  
(D)All of the above 
 
 
35 In Word Drop caps applied to  
(A)Characters (B)Sentences (C)Words (D)None of the above 
 
36 What is the term used for the word processing programs that show you 
directly on the PC screen the appearance of your final document as you might 
expect when the document is printed on the paper.  
(A)Search & Replace(B) Pagination (C)Soft Copy (D)WYSIWYG 
 
37 Using Borders in Excel you  
(A)"can add lines above, below or to either side of a cell"  
(B)"can add a single line or multiple lines, along one side of   a cell or 
around it"  
(C)both a and b above are correct  
(D)None of the above 
 
38 A Word file can be save as a Web page which is a document that consist of 
one or more parts  
(A)that can be read by a Web  browser such as the Internet Explore  
(B)saved in HTML format  
(C)which helps distribute information over the Internet  
(D)All of the above 
 
39 The length of a file’s name under Win95/98/XP _____.  
(A)is limited to 11 characters  
(B)is limited to 255 characters  
(C)is not limited in length  
(D)can contain only one space 
 
40 "After a table has been created, which of the following operations cannot 
be performed?"  
(A)Insert rows in a table  
(B)Delete and insert columns  
(C)Split the table into two tables  
(D)None of the above 
 
41 The Magnifier button is available on the  
(A)Print Preview toolbar  
(B)Standard toolbar 
(C)Formatting toolbar  
(D)None of the above 
 
42 "In the print dialog box of Word, you can select"  
(A)All page in a range (B)Odd pages (C)Even pages (D)Any of the above 
 
43 "In Word, print preview command is found under which menu?"  
(A)File (B)Tools (C)View (D)Edit 
 
44 You can use other existing data sources with your master documents 
(A)provided "the data source contains some field names, which may or may  not be 
(B)in the master document" the data source contains the same field names 



 

 

(C)found in the  master document the data source contains different field 
(D)names than those  in the master document None of the above 
 
45 Status bar shows different types of keys:  
(A)Num lock key (B)Scroll lock key  (C)Caps lock key (D) All of these 
 
46 "In its default setting, a workbook is made up of sheets and the number 
can be extended to:"  
(A)"3,255" (B)"3,225" (C)Limited by available memory (D)"16,225" 
 
47 "In Excel, once a range has been named, you can go to a range"  
(A)by selecting ranges using the name box  
(B)by selecting ranges using the [F5] key  
(C)both a and b  
(D)None of the above 
 
48 The purpose of AutoSum in Excel is to  
(A)locate and total the rows or columns in a range nearest to  the current cell 
(B)total any range that you select  
(C)add grand totals to a range containing other totals  
(D)All of the above 
 
49 Which one of the following can be entered as a number in a cell?
 (A)"1,300.00" (B) (5000.00) (C)1.1e+2 (D)All of the above 
 
50 A page break is used to do what?  
(A)Create a new page at the insertion point  
(B)Create a new page at the bottom of the document  
(C)Create a new page that cannot be deleted  
(D)Create a blank page at the top of the document 
 
51 Animation effects appears in the Standard toolbar.  
(A)True (B)False   
 
52 Hybrid computer is a mixture of both digital and analog computers.
 (A)True (B)False   
 
53 "When you create a formula that contains a function, the Insert Function 
dialog box helps you enter worksheet functions."  
(A)True (B)False   
 
54 You can enlarge the sheet upto 500% while printing.  
(A)True (B)False   
 
55 "To insert a header or footer in a worksheet, select Header and Footer 
option in the File menu."  
(A)True (B)False   
 
56 You can search for a file in Windows even if you know only part of the 
file name  
(A)True (B)False   
 
57 "When you hide a slide it remains in your file, even though it is hidden 
when you run the presentation."  
(A)True  (B) False   
 



 

 

58 The AutoContent Wizard creates the structure and contents based on the 
choices you make.  
(A)True (B)False   
 
59 "If your text exceeds the size of the placeholder, Microsoft PowerPoint 
reduces the font size and line spacing incrementally as you type, to make the 
text fit."  
(A)True (B)False   
 
60 Change case command is used to change the capitalization of a sentence.
 (A)True (B)False   
 
61 You can print slides for overhead projector transparencies  
(A)True (B)False   
 
62 Unitprice is a valid name for a cell or range.  
(A)True (B)False   
 
63 You cannot change the position of the slide images on the Handout Master. 
(A) True (B)False   
 
64 "To have Microsoft Excel always use a specific currency symbol, change the 
currency symbol selected in Regional Settings in Control Panel before you start 
Excel."  
(A)True (B)False 
 
65 "When you turn on background printing, you can continue working in 
PowerPoint while you print."  
(A)True (B)False 
 
66 E-mail addresses are case-sensitive.  
(A)True (B)False 
 
67 A set of rules is known as protocol.  
(A)True (B)False 
 
68 ISP is a company that provides an Internet connection  
(A)True (B)False 
 
69 Hypertext enables you to read and navigate text and visual information in 
a nonlinear way base on what you want to know next  
(A)True (B)False 
 
70 The two parts of an e-mail address is separated by @ symbol  
(A)True (B)False 
 
71 "In SMTP, the message can be of any length"  
(A)True (B)False 
 
72 HTML files are text files only  
(A)True (B)False 
 
73 In Web site designing you should make the title catchy descriptive and 
accurate  
(A)True (B)False 
 



 

 

74 "A smiley, is a sequence of ordinary printable characters, or a small 
image, intended to represent a human facial expression and convey an emotion."
 (A)True (B)False 
 
75 You can draw objects in a presentation by using the Design toolbar.
 (A)True (B)False 
 
76 "To create a new worksheet, select worksheet from the file menu."  
(A)True (B)False 
 
77 "In a multi-page document, the dotted line that extends on a page is 
called as soft page break."  
(A)True (B)False 
 
78 Numerals have the same widths in a proportionally spaced font.  
(A)True (B)False 
 
79 You cannot use different page-numbering styles in different section of 
your document  
(A)True (B)False 
 
80 "In Word, the ruler is displayed by default."  
(A)True (B)False 
 
81 Even and odd pages can have different footers in Word.  
(A)True (B)False 
 
82 Headers and footers are displayed in the normal view in Word.  
(A)True (B)False 
 
83 The AutoFit to contents enables Word to widen or narrow columns based on 
the contents you insert in Insert Table.  
(A)True (B)False 
 
84 You can use the AutoFormat command to analyse the formatting in the 
document and automatically create styles for you.  
(A)True (B)False 
 
85 Page preview shows the page in WYSIWYG mode.  
(A)True (B)False 
 
86 Print Preview of Word does not allow you to do any editing.  
(A)True (B)False 
87 "To fill a formula into a range, select the cell that contains the formula 
and then drag the fill handle downward, upward, right or left as far as you 
need."  
(A)True (B)False 
 
88 "In Word, the easiest way to resize a picture is by dragging its edges to 
match the size and shape you want."  
(A)True (B)False 
 
89 A blog is a website where entries are made in journal style and displayed 
in a reverse chronological order.  
(A)True (B)False 
 
90 Multiple non adjacent ranges can be selected in Excel.  



 

 

(A)True (B)False 
 
91 Pressing [Home] moves the active cell to column A of the current row
 (A)True (B)False 
 
92 Pressing [Shift]+[Spacebar] selects the entire column.  
(A)True (B)False 
 
93 You cannot move or copy sheets from one workbook to another  
(A)True (B)False 
 
94 [Ctrl]+[End] moves the last cell containing contents in the worksheet in 
Excel.  
(A)True (B)False 
 
 
95 "When you copy a formula in Excel, relative cell references do not change"
 (A)True (B)False 
 
96 "In Excel, The delete and clear commands perform the same function."
 (A)True (B)False 
 
97 Excel cannot insert multiple rows in its sheet.  
(A)True (B)False 
 
98 You can add a new sheet to the workbook by using Worksheet command on the 
Insert menu. The new worksheet is inserted in front of the current sheet.
 (A)True (B)False 
 
99 Microsoft Excel ignores manual page breaks when you use the Fit to option 
of the Page Setup.  
(A)True (B)False 
 
100 Styles can be used to generate a table of contents quickly in Word.
 (A)True (B)False 


